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1. Introduction 
What is MassEasy ? 
The adoption of Customer Relationship Management (CRM) and the wide 
coverage of the inexpensive Internet & telecommunication made segmented & 
personalized marketing campaigns never been easier and cost-effective via 
email and SMS. 

 
MassEasy is a windows-based application which offers business marketers a 
simple, yet powerful tool for segmented & personalized email and SMS 
marketing. It works with most CRM applications and various data repositories to 
streamline & automate the marketing campaigns workflow from customer 
segmentation, content merging, campaign scheduling to actual email and SMS 
distribution. The incredible high-speed Merge Engine & Send Engine delivers 
large quantity of personalized emails and SMS  to your clients, prospects or 
subscribers efficiently & independently. 

 
Once the software properly installed & configured, business marketers can finish 
their marketing campaign themselves in 4 simple steps ONLY: 

1. Create a new campaign or create from the existing template. 
2. Specify the data source and filtering criteria. 
3. Load the content template, Email includes: Content (in text or HTML) and 

attachments (if required); SMS includes: Content (in text) 
4. Save the campaign and schedule a new task immediately or at a scheduled 

data/time. 
 
MassEasy help you handle the enormous challenges you face: prepare the target 
mailing list and mobile phone number lists, merge the personalized content & 
attachments, and distribute the contents in high speed. It makes your life easier 
and saves much your time for other aspects. 

 

Features 
u Email and SMS support: Deliver content to customers both by email and 

SMS. 
u Template support: Offer campaign template, Email and SMS content 

template, attachment template etc. Users can create or edit the content of the 
template. 

u Data File Support: Read data files, including text file (CSV), MS Access  
(MDB) & MS Excel (XLS) as data source. 

u ODBC Database Support: Read ODBC databases including MS SQL Server, 
Oracle, MySQL, FoxPro (via ODBC), and all ODBC-capable database 
systems. 

u Data Source Filtering: Filter and segment the target customers by selecting 
the table/query and certain database criteria. 

u Data Capture Preview: Verify the query results of the target recipient list and 
merge fields before actually conducting a merge. 

u Content Personalization: Create customized, personalized emails by 
merging pre-defined merge fields in the content template from data sources. 

u Unlimited No. of Merge Fields: Insert as many fields as you want from the 
data source into the content template. Includes the recipient's name, email 
address or other information in numeric or text. 

u HTML Content Support: Merge & send HTML emails with standard HTML 



tags, ASP, Javascript, Flash, in the content template. 
u Multiple Email Attachments: Allow to attach multiple files as email 

attachment to send. 
u Email Preview: See the actual view of a merged email or SMS in the format 

which they support (in plain text or HTML) before they're sent. It is really "What 
You See Is What You Get". 

u Flexible Scheduling: Schedule tasks of campaign to be launched 
automatically at the specific data/time. It can be selected to capture the 
mailing list & merge fields from the data source immediately (IMMEDIATE 
DATA) or at the task's scheduled date/time (SCHEDULED DATA). 

u Multiple Campaigns/Tasks Support: Create multiple marketing campaigns 
and schedule multiple tasks for each campaign simultaneously. 

u Multi-lingual Content Support: Merge and send contents with different 
characters sets, (e.g. Traditional Chinese, Simplified Chinese, Japanese, 
Korean, etc..) no matter in merge fields, in message text or in HTML content. 

u Campaign Acknowledgement: An acknowledgement email or SMS 
specifying the status, would be sent to the specified mailbox or mobile number 
after the completion of the campaign task. 

u True Multi-threading: Merge Engine & Send Engine are working 
simultaneously as program threads in pipelining. Need not to wait for all 
messages of a task merged before sending the first emails. 

u Auto System Recovery & Resume: In case of  the system halted by any 
means, the working campaigns and scheduled tasks can be automatically 
recovered and resumed from the dead point when the system is up again. It 
prevented to re-send the tasks from the beginning and occur duplicated or 
missed emails. 

u Incredible Speed: Capable of merging 50,000 & sending 100,000 emails per 
hour. 

u Dynamic SMTP Data Flow Control: Automatically slow down MassEasy's 
fast email sending on-demand to allow slow Mail Servers to "catch their 
breath." This can help avoid overloading the slow mail servers. 

u Various SMTP Mail Server Support: Microsoft IIS, Microsoft Exchange, 
Lotus Domino, Linux SendMail, and all SMTP-compliant mail servers.  

u FREE Opt ional SMTP Mail Server: A FREE SMTP Mail Server (Mail Enable) 
is bundled w ith seamles s integration into the MassEasy installation. Need not 
to have or to integrate w ith an existing SMTP server. (Suppor ts Window s 
2003/2000/NT4.0/Me/XP,  except Window s 98). 

u Configure SMTP Mail Server by IP or by Hostnames: Capable of resolving 
SMTP Mail Server's IP address by hostname automatically from DNS server.  

u Multiple Email Sending Profiles: Use unique from, reply-to email addresses 
for each campaign. 

  



Platforms and System Requirements 
u Pentium class PC 
u 128 MB RAM (256MB /smtp server) 
u 7MB free disk space 
u Support Microsoft Windows 2000/NT4.0/Me/98/XP 
u a SMTP server for email relay, e.g. Microsoft IIS, Microsoft Exchange, Lotus 

Domino, Linux SendMail 
u TCP/IP (Internet) network connection 
u Microsoft Data Access Components (mdac_typ.exe) v2.5 or above 
u Microsoft Internet Explorer v4.7 or above (for HTML format email preview) 
u For sending SMS, there must be a correct connection with internet and 

register on ITOK SMS server(www.meeteasy.com) 
 

Download 
You may download the latest version or service patches of MassEasy from 
http://www.masseasy.com. 

 

Technical Support 
If you have any question or problem that are not explained in this documentation, 
you may contact ITOK Technologies Limited for support. If you have a problem, 
please record all the details you can get us to help you. 

 
Hotline: +852 2345-1562 (9am-6pm, HKG Time) 
FAX Number: +852 2566-5740 
Email: support@masseasy.com 
Web: http://www.masseasy.com 
  



2. Installing MassEasy 
This chapter guides you how to install MassEasy and what pre-installation is 
needed. 

 

Pre-Installation 
MassEasy requires the following component installed to work properly.  
Microsoft Internet Explorer v4.7 or above. 
If your machine has not installed these components, please follow the following 
steps to install them first. 

 

Installation of Microsoft Internet Explorer 
Download IE5.5 (ie5setup.exe) from http://www.microsoft.com 
In Window Explorer or File Manager, double click on ie5setup.exe. Installation will 
start automatically. 

Follow the step with the Installation wizard until the installation complete. 
 

Service Account 
For Windows NT, Windows 2000 and Windows XP users, please create a service 
account to install MassEasy. 

 

Installation  
u In Windows Explorer or File Manager, double click on SETUP.EXE. 
u All supported languages are showed in the installation wizard dialog. Choose 

the one you want to install. 
u Select the MassEasy edition you wish to install.MassEasy Trial Edition is a full 

version of MassEasy but it has 30 days time limit. MassEasy Personal Edition 
does not have the time limit but some functions are restricted Both versions 
can be registered and upgraded to advance version.  

u Read the License Agreement. Click “Agree” if you agree with the terms. 
u Select MassEasy Components you wish to install, “ Complete”  or 

“ Custom” . “ Complete”  opt ion includes MassEasy Main Application, 
Help Documents and a free SMTP server-MailEnable. While the “ custom”  
option only installs the components you choose to install Note: If you choose 
to install MailEnable, It will pop up a dialogue boxes requesting to restart the 
computer after MailEnable installation. Please ignore this dialogue box by 
pressing “Cancel” button and don’t restart your computer until the end of 
MassEasy Installation. 

u After copying the selected components, MassEasy would also upgrade data 
access component such as MDAC. 

u After Installation, Please restart the computer. 
  



3.Registration of MassEasy 
Starting MassEasy first time will go through the following two steps: 
1. User Information 
2. Registration 
 

User Information (Registration step 1 of 2) 
This step involves the submission of registered user information. Registered 
users can receive updates of MassEasy information by email. 

 
Fill in user information 
Click “Next” button 
 
Users can skip the collection of user information by clicking the SKIP button. 
However, this Registration dialog appears at every startup of MassEasy. 

 

 
Figure1.Registration step 1 of 2 

 
 

 



Registration (Registration 2 of 2) 
This step involves Evaluation / License Registration with Online or Offline method.  
 
Online Registration 

1. Input Serial Number for license registration or click the check box “Evaluation 
Version” for evaluation version registration. 

2. Click “Online Registration” button.  
3. Wait for MassEasy to contact MassEasy.com and complete the registration. 

  
Similarly, users can Skip this step by clicking SKIP button. Users skipping this 
registration step are using MassEasy Trial Edition. MassEasy Trial Edition has 
full features of Standard Edition but limited to 1 campaign 1 attachment and 
expires in 30 days. 

 

 
Figure2. Registration step 2 of 2 

  



Offline Registration 
u Input Serial Number for License registration or click the check box “Evaluation 

Version” for evaluation version registration. 
u Click “Offline Registration” button. 
u A text file MseReg.txt will be generated at <INSTALL PATH>\MassEasy. 
u Send this text file by email to reg@masseasy.com or other methods. 
u An activation key will return to user within 7 days through email. 
u Click “Activation Key” button. 
u Input the 16-digit Activation Key. 
u Click “OK”.  
u Wait for MassEasy to complete the License Registration. 

 

 
Figure3. Activation Key 

 
 
 
 
 
 
 
 
 
 
 
 
  



4.Configuration of MassEasy 
A SMTP Server is required as an email relay to send message to Internet. 
MassEasy supports Microsoft IIS, Microsoft Exchange Server, Lotus Domino, 
Linux SendMail and any SMTP compatible server. 

 

Configure MassEasy SMTP settings  by the steps. 
1. Select from the top menu “Configuration > SMTP Server” or click the 

“Configuration” Button at the left Shortcut Menu.  
2. Enter the SMTP Server host name or IP address. 

 

 
Figure4. MassEasy Configuration 

  
Control Email Transmission Rate  
Email transmission rate can be controlled by the user. ( e.g. User is allowed to 
send a maximum of 2000 emails in one hour) 

 



Control Email Transmission Rate by the following steps  below.  
1. Select from the top menu “Configuration > Performance Tuning” or click the 

“Configuration” Button  at the left Shortcut Menu. 
2. Enter maximum email allowed to be sent per hour (at least 1 email and at most 

360000 emails) 
3. Press the Save button and restart MassEasy to apply new settings 

 

 
Figure5. Control of Email Transmission Rate 

 
  



5.Preparation for MassEasy 
Before sending a marketing campaign by MassEasy, some preparations  work 
have to be done. 

1. Prepar a Marketing Campaign 
2. Before creating & configuring a marketing campaign, user has to prepare the 

followings: 
 

Data Source 
User has to prepare the data source file or database system containing email list 
and personalized merge data (if any) for distribution. Below are the file types and 
database systems that are supported by MassEasy. 

 
u ODBC connection - (for Standard or Professional Edition ONLY) - MassEasy 

can connect to any ODBC compatible system such as Oracle, MS SQL and 
MySQL to capture data source. The authorized login name and password are 
required to connect to the ODBC Database. 

 
u Text (CSV) file - MassEasy supports text based data source file  in the format 

of Comma Separated Variables (CSV). 
 

u Microsoft Access file  - MassEasy supports Microsoft Access 97 or above 
version. The language of Microsoft Access Database File supported is 
depends on the OS of the machine. Microsoft Access Database File operated 
on different language of OS is not guaranteed. 

 
u Microsoft Excel file  - If user would like to use an Excel file as data source, 

user must ensure that the format of the Excel file is in ODBC standard. An 
ODBC standard Excel file contains the Column name at the first row and a 
Name Label defining the area of data.  

 
Here is an example. 

 

 
Figure6. Column Name / Field Name in Excel data source format 



  
Figure7. Define Name on Excel data file format 

 
 

Content  
Users is required to save marketing materials in the form of a Content Template. 
MassEasy supports email content in both HTML and TEXT formats, while SMS 
supports content in TEXT format. 

 
HTML – Other than standard HTML tag, MassEasy also supports HTML file 
contains Javascript, asp and flash.  

TEXT – Plain Text is supported by MassEasy as well. 
 
Remark: The image in HTML file should be the absolute location accessed 
through Internet. (i.e. starting with http://) 

 
  



6.Starting MassEasy 
Start MassEasy and follow these steps below to complete a marketing campaign: 
1.Create a Campaign Template 
2.Create a Campaign 
3.Define a Campaign 
4.Create a Task 
5.Define a Task 
 

Step1. Create a Campaign template 
1. Click “Template” button on the left Shortcut Menu and click “New” or select 

“File > Te mplate> New” at top pull-down menu. 
2. Enter a template name and click “OK”.(Duplicate template name is not allowed) 
3. “Template Definition” window pops out. 
4. The way to define a campaign template is the same as “Define a campaign”, 

please refer to the chapter “Define a campaign” for more information. (Note: 
Defining Content in campaign template is a part of creating a template) 

Step2. Create a Campaign 
1. Click “Campaign” button on the left Shortcut Menu and click “New” button 

below the Campaign List window or select at top pull-down menu “File > 
Campaign > New”. 

2. Enter a campaign name and select a send method. You can create a new 
campaign or create from the existing template. 

3. The window “Campaign Definition” will prompt out. 
 

Step3. Define a Campaign 
In the Campaign Definition Window, you can find three tabs: Data Source, 
Content and Send Option. The Campaigns of Email and SMS are explained 
below: 

 
The campaign definition for Email 
3.1.1 Define Data Source 

u Data Type (Mandatory) 
Select the Type of Data Source contains the Email List and/or Merge Data.(For 
the supported data source and details, please refer to Preparation for a 
Marketing Campaign). 

u Database Path (Mandatory) 
Choose the data file or DNS available on user’s machine by clicking the  

button .  
u Table/Query Name (Mandatory) 

Once the user has chosen the data file or DNS, MassEasy will check out all 
table names that are available from the data source. Select the one contains 
the Recipient’s Email Address. 

u Recipient Field (Mandatory) 
Choose the Field Name which contains the recipient’s email address. 



 
Figure8-1  MassEasy Campaign Definition for Email 

 
u Recipient Field (Mandatory) 

Choose the Column Name / Field Name which contains the recipient’s email 
address. 

u Number of Message  
Once the Recipient Field has been provided, MassEasy checks the data 
source and shows the number of messages available for send. 

u Data Filters 
Click the check box besides Data Filters will enable the data filters. Details for 
how to set the data filters will be discuss later in Advanced Feature – Data 
Filters. 

 
3.1.2 Define Content 

u Subject  
Enter email subject. 

u Content Format (Mandatory) 
User may choose to send emails with content in HTML format or TEXT 
Format. 

u Personalize with Merge Fields  
Click the check box besides “Personalize with Merge Fields” to merge 
personalized data into content template for each recipient. Details for how to 
create a marketing material with personalized data will be discussed later in 
Advanced Feature – Personalize email message 



 
u Configure Personalized Fields Mapping 

After checking the check box “Personalize with Merge Fields”, users can setup 
the existing personalized fields by clicking “Merger Fields Mapping”. Users can 
specify which field in the data source merged with the personalized field in the 
template and set the maximum length. 

u Define Content (Mandatory) 

The button   is to 
select the source of content. It can be a file or defined content template. User 
can also preview the content in Text format and HTML format by clicking the 
tab. If user selects check box  "Personalize with Merge Fields", then what you 
can see is the result after personalization. You can also browse all the 
personalized emails by clicking "Pre>> " and "Next". 

 

 
Figure8-2. MassEasy Campaign Definition For Email 

 
 
 
 



 
u Attachments  

Click “File” button besides the Attachments to add file(s) as attachment sent 
with email messages. You can also click on the pull down manual to choose 
an attachment template, users also can save the selected content as a 
"attachment template”. If you want to remove the selected attachment, what 
you need to do is to click “Delete” button to remove it. The no. of attachment 
allowed to be sent is depends on the MassEasy edition you are using. Notes: 
Any binary files can be added as attachment. 

u Disclaimer 
Click “Disclaimer  …  “button to edit the content of Disclaimer to be sent. User 
can choose to send disclaimer as header or footer with the message content. 
Disclaimer can only in Text Format. The permission of changing content and 
position of the disclaimer is depending on the MassEasy edition you are using. 

 
3.1.3 Define Send Options 

u Sender Name 
Enter Sender’s Name which will be display as “Sender” in email messages 

u Sender Email (Mandatory) 
Enter Sender’s Email Address. 

u Reply To  
Enter a email address you would like recipients to reply to. If this field is mitted, 
the sender email address will be set as default Reply To email address. 

u Send Acknowledge Email To  
Input an Email Address where an acknowledge email will be send to after a 
task completed. The email contains a simple task report summarizing how 
many emails have been sent out successfully. Click "add" button to add 
multiple recipients. 

 

The campaign definition for SMS 
3.2.1 Define Data Source 

u Data Type (Mandatory) 
Select the Type of Data Source contains the mobile numbers List and/or 
Merge Data.(For the supported data source and details, please refer to 
Preparation for a Marketing Campaign). 

u Database Path (Mandatory) 
Choose the data file or DNS available on user’s machine by clicking the 

button .  
u Table/Query Name (Mandatory) 

Once the user has chosen the data file or DNS, MassEasy will check out all 
table names that are available from the data source. Select the one contains 
the Recipient’s mobile numbers. 

u Recipient Field (Mandatory) 
Choose the Field Name which contains the recipient’s mobile numbers. 

 



 
Figure 8-3 The campaign definition for SMS 

 
u Number of Message  

Once the Recipient Field has been provided, MassEasy will check the data 
source and show how many messages is available for distribution. 

u Country or Region Code 
Every Country or region has its unique prefix dialing code. Select a country or 
a region to specify where the recipient are in the campaign. 

u Data Filters 
Click the check box besides Data Filters will enable the data filters. Details for 
how to set the data filters will be discuss later in Advanced Feature – Data 
Filters. 

 
3.2.2 Define Content 

u Personalize with Merge Fields  
Click the check box besides Personalize with Merge Fields to merge 
personalized data into content template for each recipient. Details for how to 
create a marketing material with personalized data will be discussed later in 
Advanced Feature – Personalize email message. 

u Configure Personalized Fields Mapping 
After checking the check box “Personalize with Merge Fields”, users can setup 
the existing personalized fields by clicking “Merger Fields Mapping”. Users can 
specify which field in the data source merged with the personalized field in the 
template and set the maximum length. 
 
 
 



u Define Content (Mandatory) 

The button  is to select 
the source of content. SMS content support files or templates in TXT format 
only. If user selects check box "Personalize with Merge Fields", then what you 
can see is the result after personalization. You can also browse all the 
personalized emails by clicking "Pre>> " and "Next" 

 

 
Figure9 The campaign definition for SMS 

 
u Disclaimer 

Click “Disclaimer … “button to edit the content of Disclaimer to be sent. User 
may choose to send the disclaimer as header or footer with the message 
content. Disclaimer can only be in Text Format. 

 
3.2.3 Send Options 

u Sender Name 
Enter Sender’s Name and it will be displayed in SMS Sender’s field  

u Sender mobile number (Mandatory) 
Enter Sender’s mobile number and it will be displayed in the SMS  
 
 



u Send Acknowledge SMS To 
Enter a mobile number which an acknowledge SMS will be sent to after a task 
completed. The SMS contains a simple task report summarizing the no. of 
SMS have been sent out successfully. 

u Login ID and Password 
You can get a login ID and password in the ITOK SMS server 
(www.meeteasy.com). SMS task can’t be completed unless there is enough 
balance in the account. 

 

Step4.Create a Task 
After defining a Campaign, user can schedule a Task to be executed at specified 
date/time. It applies all current Campaign settings e.g Data Source, Content, and 
Send Options to the task created. 

 

u Click “Task (Scheduled)” button  on the left Shortcut Menu and click 
“New” button below the Task List window or select at the top pull-down menu 
“File > Task > New”.  

u Task Definition Window will pop out. 
 
Once the task has been created from one Campaign, the changes in that 
Campaign will not take effective on the task created. (No matter it is scheduled 
task or immediate task.) User is needed to create another new task in order to 
apply the new changes in that Campaign. 

 



Step5.Define a Task 
u Campaign 

Select the Campaign that the Task scheduled from. 
u Task Name 

Enter a Task Name. 
u Send Time of a Task 

Select the Task is need to send immediately or at scheduled time by clicking 
the appropriate option. 
Select the Date and Time for a scheduled Task. 

u Data Capture Mode  
User can select a scheduled task take Immediate Data from the data source or 
capture data at the Scheduled Time 
Immediate Data – For a scheduled Task with Immediate Data, MassEasy will 
import the email list and personalize data from data source when the task 
created. 
Scheduled Data – For a scheduled Task with Scheduled Data, MassEasy will 
import the email list and personalize data from data source at the scheduled 
time. 

 

 
Figure10. MassEasy Task Definition 

  



7.Advanced Feature in MassEasy 
u Task Manipulation 

MassEasy provides several manipulations for each task such as Reschedule, 
Restart, Resume, Stop, Cancel and View Log for a task. 

u Reschedule  
User can click the button “View Log” to view the result of the task, no matter 
the task is completed or not. (Note: Except at the moment the task is 
completing, i.e while the log is written. In that case, users have to wait for a 
few seconds) 

u Restart 
User can restart a stopped task and pending task. The whole task will be 
resent from the beginning of the mailing list. 

u Resume 
User can resume a stopped task and pending task. The task will be resent 
from last stopped point  of the mailing list. Only those un-sent email 
addresses w ill be sent. 

u Stop 
User can stop a running task or a scheduled task. 

u Cancel 
User can cancel a scheduled task or a pending task. Once the task is 
cancelled, it can not be restart or resume again. 

u View Log 
For a completed task, user may click the button “View  Log” to view the 
distribution result of the task. 

u Database Filter 
When distributing marketing material, user may want to segment their target 
customers with tailor-made content.. MassEasy provides a basic database 
filter for this purpose. User only needs to specify the field and input the 
required value. 

 
For example, a user wants to send message only to those recipients who aged 30 
or above. Follows these steps to set up the Data Filters: 

1. Click the check box beside “Data Filters” and enable the database f ilter 
to work. 

2. Select the Field Name in the selection box that contains the age of 
receiver. 

3. Select the operator “>=” in this case. 
4. Input the required value 30 into the value column. 
5. Click button “Refresh”. The number of message that meets this 

requirement will be reflected immediately at No. of Recipients 
/Messages Queried. 

6. User may also click button “Preview” to view the data records that meet 
this requirement. 

 

 
Figure11.MassEasy Database Filters 



 
7. Users can click the check box of “filter repeated recipients”. The 

repeated email or mobile number will be sent just once. 
 
 Remarks: 

1. The information of criteria field should be contained in the same table / 
view of receiver email address/mobile number. 

2. When the required Value is a string, a “’” is needed to quote the value. 
(Example: ‘Hong Kong’) 

3. User can set up to five criteria for data filtering. 
  
 

u Personalize with Merge Fields 
MassEasy supports user to send recipient message with personalized 
information.  

 
User just need to click the check box beside Personalize with Merge Fields when 
defining Content in Campaign Definition and add Merge Field(s) into the Content 
Templates.Follow these steps to add token(s) into materials: 

1. Open the marketing material with editor. 
2. Move the cursor to where the personalized information will be added. 
3. Type in the exact Field Name which containing the personalized 

information and quote it with “{#%” and “%#}”. 
4. Example:  

Where ShopperName is the field name that contains the data of shopper 
name. When the message send out to the recipient, it would be replaced 
by the data of shopper name provided.(refer to Point5 for reference.) 

5. Users can also modify the corresponding field of personalized 
information when defining or editing the campaign. Click “Configure 
Personalized Fields Mapping” in the “Content” page, and then select the 
corresponding field in the database. It also allows to set the maximal 
length. MassEasy will replace the personalized field according to the 
user’s configuration when it is merging. If there is no configuration of 
these fields mapping, MassEasy will process as what Point 4 described. 
 

u Recovery / Resumption Mode 
When a Task is running and MassEasy has been stopped, un-completed tasks 
will be recovered. MassEasy enable user to resume these tasks and continue 
the task from the dead point. MassEasy provides two options for task 
resuming. 

u Auto Resume 
When MassEasy start, it checkes if there is recovered task in the task list. 
MassEasy will continue to send the outstanding email automatically. 
 
 
 
 
 
 
 

Dear {#%ShopperName%#}, 
We are appreciate to tell you that…  
 



u Resume with user confirmation 
When MassEasy starts, it will check if there is recovered task in the task list. 
MassEasy will ask the user if he/she would like to resume these tasks, 
reschedule the task or cancel the task. 
User can change the mode of Resumption by clicking the Configuration button 

 and select the tab “Options” or select from the top menu “Configuration > 
Options”. 

 
u Select Format of Graphics for sending 

There is a check box for users to choose the sending format of embedded 
graphics in the Email. Take Microsoft Outlook Express and Microsoft Outlook 
2000 as examples to explain as follows: 

 
These procedures only apply if you have installed Outlook with the Corporate 
or Workgroup option. This option allows you to use Messaging Application 
Programming Interface (MAPI) services. To determine your installation type, 
on the Help Menu click About Microsoft Outlook. In About Microsoft Outlook 
you should see "Corporate or Workgroup" if you have the Corporate or 
Workgroup installation. 
 
Illustration: The problem mentioned above which possibly happened in 
Microsoft Outlook 2000 will happen just in the following case: 
 
“Microsoft has confirmed this to be a problem in Microsoft Outlook 2000”, 
which has been mentioned in this file. 
 
MassEasy strongly suggest that all the pictures in emails in HTML format use 
“absolute path”, i.e in the format of http://” or “https://”. If it has to use 
embedded graphics, MassEasy will advice you to click the check box of “send 
embedded graphics as standard attachment”. 
 

u Compress database 
Users can configure MassEasy to compresses the database when it reaches 
to XXMB, the compression always does in the next startup of MassEasy. The 
database is the internal database of MassEasy and the storage efficiency 
would be increased by compressing database., 

Sending 
Format of 
Graphics  

Microsoft Outlook 
Express 

Microsoft 
Outlook 2000 

Don't send as 
standard 
attachment 

display normally  the whole email 
would be 
treated as 
attachment 

Send as 
standard 
attachment 

Can display the content 
and pictures, but all the 
pictures will be in the 
attachment box so that 
the recipient can’t 
distinguish which ones 
are added by the 
sender. 

Display normally, 
only 
attachments the 
sender added 
will be displayed 
in the 
attachment box. 



8.Troubleshooting 
Here are some questions you may ask: 
1. Why can’t MassEasy find any email record in Excel (*.xls) Data Source file 

when I defining the Data Source for a Campaign? 
Ans: It is because a Name label in Excel (*.xls) Data Source file is need in 
order to enable the connection driver to recognize the valid data source. For 
details, 
you may refer to 5. Preparation for MassEasy. 
 

2. Why can’t the personalized data in email content be displayed even if I have 
already click the “Personalized with Merge Fields” option? 
Ans: Make sure the merge field name in you content template is exactly the 
same with those in the data source table. For details, you may refer to : 
Personalize with Merge Fields. 
 

3. Why most of the response code are “554” Transaction failed” when I view the 
log for a completed task? 
Ans:  It may because of the insufficient capacity of SMTP Server. You may 
tune the performance by setting a smaller value for the option “No. of SMTP 
Connections” in Configuration Setting. 
 

4. I sent emails (in HTML format) by MassEasy, why did some recipients say that 
they received an attachment named “untitled.eml”  
Ans:  Maybe the picture format you set is incorrect. Please refer to 
“Advanced Features”-“Select Sending Format of Graphics” 
 

5. Does the completion of the task in MassEasy means all the emails or SMS 
have been sent successfully? 
Ans: For SMS, the completion of the task is the completion of sending, users 
can view the log to check the status. But for Email, the completion of the task 
only means that MassEasy successfully submitted all the information to the 
SMTP server, which will do proper broadcast according to the configuration 
and network performance. 
 

6. Why can’t I send SMS by MassEasy? 
Ans: Please make sure that you have correctly connected to internet and 
registered in our SMS server. Then check your login ID and password and if  
there is enough balance to send SMS. You can view the log of failed tasks to 
get more details or contact to our technical support. 

 

 

 


